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File menu commands

The File menu offers the following commands:

New Creates a new channel list.
Open Opens an existing channel list.
Save Saves an opened channel list using the same file name.
Save As Saves an opened channel list to a specified file name.
Exit Exits iSiloWeb.



Edit menu commands

The Edit menu offers the following commands:

Cut Deletes the selected channels from the list and moves them to the clipboard.
Copy Copies the selected channels to the clipboard.
Paste Pastes channels from the clipboard into the channel list.
Delete Deletes the selected channels from the list.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Channel menu commands

The Channel menu offers the following commands:

Add File Adds a file channel to the list.
Add Web Adds a web channel to the list.
Convert Converts the selected channels.
Convert All Converts all channels in the list.
Properties Shows the properties of the selected channels.
Default Properties Modifies the default settings for new channels.



Tools menu commands

The Tools menu offers the following commands:

Options Modifies iSiloWeb settings.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new channel list in iSiloWeb.

You can open an existing channel list with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing channel list.

You can create new channel lists with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Drives
Select the drive in which iSiloWeb stores the file that you want to open. 

Directories
Select the directory in which iSiloWeb stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save command (File menu)

Use this command to save the active channel list to its current name and directory.    When you save a 
channel list for the first time, iSiloWeb displays the Save As dialog box so you can name your document.   
If you want to change the name and directory of an existing channel list before you save it, choose the 
Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active channel list.    iSiloWeb displays the Save As dialog box 
so you can name your channel list.    

To save a channel list with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the channel list you're about to save:
File Name

Type a new filename to save a channel list with a different name.    iSiloWeb adds the extension you 
specify in the Save File As Type box.

Drives
Select the drive in which you want to store the channel list.

Directories
Select the directory in which you want to store the channel list.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four channel lists 
you closed.    Choose the number that corresponds with the channel list you want to open.



Exit command (File menu)

Use this command to end your iSiloWeb session.    You can also use the Close command on the 
application Control menu.    iSiloWeb prompts you to save the active channel list with unsaved changes 
unless the option to save it automatically is set.

Shortcuts
Keys: ALT+F4



Cut command (Edit menu)

Use this command to remove the currently selected channels from the list and put them on the clipboard.  
This command is unavailable if there are no channels currently selected.

Cutting channels to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected channels onto the clipboard.    This command is unavailable if there 
are no channels currently selected.

Copying channels to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V



Delete command (Edit menu)

Use this command to delete selected channels.    This command is unavailable if there are no channels 
currently selected. Note that this operation cannot be undone. You will be asked for confirmation before 
the selected channels are deleted.

Shortcuts
Keys: Del



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common 
commands in iSiloWeb, such as File Open.    A check mark appears next to the menu item when the 
Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in iSiloWeb,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Create a new channel list.

Open an existing channel list.    iSiloWeb displays the Open dialog box, in which you can locate 
and open the desired channel list.

Save the active channel list with its current name.    If you have not named the channel list, 
iSiloWeb displays the Save As dialog box.

Remove selected channels from the list and stores them on the clipboard.

Copy the selected channels to the clipboard.

Insert the contents of the clipboard at the insertion point.

Convert the selected channels.

Convert the entire channel list.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the 
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to 
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the iSiloWeb window.    To display or hide the status bar, use 
the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar buttons as you 
depress them, before releasing them.    If after viewing the description of the toolbar button command you 
wish not to execute the command, then release the mouse button while the pointer is off the toolbar 
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.

NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Add File command (Channel menu)

Use this command to add a file channel to the list.

Shortcuts
Keys: Ins



Add Web command (Channel menu)

Use this command to add a web channel to the list.

Shortcuts

Toolbar:
Keys: Alt+Ins



Convert command (Channel menu)

Use this command to convert the selected channels.

Shortcuts

Toolbar:
Keys: F5



Convert All command (Channel menu)

Use this command to convert all channels in the list.

Shortcuts

Toolbar:
Keys: Alt+F5



Properties command (Channel menu)

Use this command to show the properties of the selected channels in the list.

Shortcuts
Keys: Alt+Enter



Default Properties command (Channel menu)

Use this command to show the default properties for new channels added to the list.

Shortcuts
None



Options command (Tools menu)

Use this command to modify iSiloWeb settings.

Shortcuts
None



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using iSiloWeb and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of iSiloWeb.



Context Help command

Use the Context Help command to obtain help on some portion of iSiloWeb.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the iSiloWeb window, such as another Toolbar button.    The Help topic will be shown for 
the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title 
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave in your 
application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 

border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the iSiloWeb window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    iSiloWeb determines which window is 
next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    iSiloWeb determines which window
is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or close an 
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following 
options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does not 
affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)

<< Write application-specific help here. >>



Choose Font dialog box

<< Write application-specific help here. >>



Choose Color dialog box

<< Write application-specific help here. >>



Find command (Edit menu)

<< Write application-specific help here. >>



Find dialog box

<< Write application-specific help here. >>



Replace command (Edit menu)

<< Write application-specific help here. >>



Replace dialog box

<< Write application-specific help here. >>



Repeat command (Edit menu)

Use this command to repeat the last editing command carried out.    The Repeat menu item changes to 
Can't Repeat if you cannot repeat your last action.

Shortcut
Key: F4



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should modify a 
document using your application.    

If your application supports multiple document types and you want to have a distinct help topic for each, 
then use the help context i.d. generated by running the MAKEHELP.BAT file produced by AppWizard.    
Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the help 
context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the first 
document type supported by your application.    AppWizard produces an alias in the .HPJ file for your 
application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for that document type. >>





No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the AFX_HIDP_xxx 
values from the [ALIAS] section of your .HPJ file, and author a topic for each AFX_HIDP_xxx value.    For 
example, AFX_HIDP_INVALID_FILENAME is the help topic for the Invalid Filename message box. >>



iSiloWeb
iSiloWeb converts HTML, Doc, and text files to the popular iSilo(TM) document. More information about 
iSilo(TM) can be found at:

http://iSilo.com

iSiloWeb allows you to specify channels of information. A channel specifies the source of content for a 
document. The channel may be specified as a URL in the case of content from a web server over the 
Internet, the path name of a file on your local computer, or the path name of a file on a network server. 
You can create lists of channels from which you can easily pull up-to-date information.



Documents, Pages, and Channels
The iSilo(TM) document format works in terms of documents. A document is a collection of one or more 
pages. A page can be of arbitrary length. In the case where a text file or a Doc file is converted to 
iSilo(TM) format, the resulting document will have only one page. Currently, only conversion of an HTML 
document can result in a document containing more than one page.

HTML documents
The applications that convert documents to iSilo(TM) format view an HTML document as beginning with a
root page. The root page may have hyperlinks to other pages, though this is not necessary, in which case,
the HTML document consists of only one page. If the root page does have hyperlinks to other pages, 
those other pages are considered to be at a depth of one from the root page because they are reachable 
from the root page by following one hyperlink. Similarly, pages reachable only through hyperlinks on the 
pages at a depth of one are considered to be at a depth of two from the root page.

When the converter applications convert an HTML document, they convert starting with the root page of 
the document. The root page becomes the first page of the resulting iSilo(TM) document. The converter 
applications then follow hyperlinks to additional pages up to a given maximum specifiable depth. After the 
root page, all pages reachable from the root page are added to the document. Then all the pages 
reachable through those pages are added, and so on up to the maximum specified depth. All these pages
reached from the root page are converted as a single iSilo(TM) document with the root page as the first 
page.

Channels
iSiloWeb allows you to specify channels of information. A channel specifies the source of content for a 
document. The channel may be specified as a URL in the case of content from a web server over the 
Internet, the path name of a file on your local computer, or the path name of a file on a network server. 
You can create lists of channels from which you can easily pull up-to-date information.

In the case of the World Wide Web, the concept of a document is quite arbitrary. iSiloWeb thus uses the 
term channel to define the information that comprises a single iSilo(TM) document. Again, a channel 
begins with a root page and continues with the pages identified by hyperlinks from the root page and the 
pages identified by the hyperlinks on those pages, and so on.



How to Add a Channel
A channel specifies the source of content for a document. The channel list is a convenient way of storing 
a list of frequently accessed channels.

A channel may reside on the web, on local storage, or on a network server. There are several ways to add
a channel to the channel list. When you add a channel to the channel list, the channel list stores 
information about the location of the channel.

Adding a channel from a browser
If you are using either Microsoft’s Internet Explorer browser or Netscape’s Communicator browser, you 
can easily add the currently displayed web page as a channel using a drag-and-drop operation as 
described below for your browser:

Microsoft Internet Explorer
The address bar of the browser shows the URL of the current page. To the left of the URL is an icon that 
looks like this . Drag the icon to the iSiloWeb channel list and drop it at the position in the channel list 
where you want to insert it.

Netscape Communicator
The location bar of the browser shows the URL of the current page. A little to the left of the URL is an icon
that looks like this . Drag the icon to the iSiloWeb channel list and drop it at the position in the channel 
list where you want to insert it.

Adding a file channel
A file channel is located either on local storage or on a network server. You may add a file channel in any 
of the ways described below.

Drag-and-drop from Windows
You can drag files from any of My Computer, Windows Explorer, Network Neighborhood, or the Desktop 
and drop them anywhere into the iSiloWeb channel list.

Drag-and-drop a list of files
You can drag a list of file path names to the iSiloWeb channel list. Each file path name must be on a 
separate line and each is added as an individual channel. Note that dragging a list of file path names is 
only possible if the application containing the file path name list supports drag-and-drop of text.

Paste a list of files
If you want to paste a list of file path names from an application that does not support drag-and-drop of 
text, you can instead copy the list and then paste it into the iSiloWeb channel list using the Edit menu 
Paste command. Again, each file path name must be on its own line.

Add a single file manually
Alternatively, you can use the Channel menu Add File command to select a single file to add. The Add 
File command is also accessible through the context menu obtained by right-clicking anywhere inside the 
channel list.

Adding a web channel
A web channel is located on a web server over the Internet or on your local network. Only HTTP:// web 
channels that do not require authentication are supported. Thus channels that employ encryption can not 
be converted. Additionally, iSiloWeb does not have cookie support, so channels that depend on cookies 
may not convert correctly.

You may add a web channel in any of the ways described below.

Drag-and-drop from Windows



You can drag URL shortcuts from any of My Computer, Windows Explorer, Network Neighborhood, or the 
Desktop and drop them anywhere into the iSiloWeb channel list.

Drag-and-drop a list of URLs
You can drag a list of URLs to the iSiloWeb channel list. Each URL must be on a separate line and each 
is added as an individual channel. Note that dragging a list of URLs is only possible if the application 
containing the URL list supports drag-and-drop of text.

Paste a list of URLs
If you want to paste a list of URLs from an application that does not support drag-and-drop of text, you 
can instead copy the list and then paste it into the iSiloWeb channel list using the Edit menu Paste 
command. Again, each URL must be on its own line.

Add a single URL manually
Alternatively, you can use the Channel menu Add Web command to manually specify a web channel to 
add. The Add Web command is also accessible through the context menu obtained by right-clicking 
anywhere inside the channel list.



How to Convert/Synchronize Channels
Once you have setup a channel list, you can either select a set of one or more channels to convert or you 
can convert all channels at once.

Converting only selected channels
To convert only the selected channels, you can use any of the following methods:

· Click the toolbar button that looks like this .
· Choose the Convert command from the right-click context menu
· Choose the Convert command from the Channel menu
· Hit F5

Converting all channels
To convert all channels in the list, you can use any of the following methods:

· Click the toolbar button that looks like this .
· Choose the Convert All command from the right-click context menu
· Choose the Convert All command from the Channel menu
· Hit Alt+F5

Conversion
While the channels convert, a dialog shows the progress of the conversion. You can cancel the 
conversion by clicking the Cancel button.



How to use iSiloWeb’s command line
You can invoke iSiloWeb from the command line and have it automatically convert a specified channel 
list. To see a dialog that displays options, pass either -? or -h on the command line.

iSiloWeb’s command line takes the following form:

iSiloWeb {options} ChannelListFileName

iSiloWeb only has two command line options:

· -c Convert the specified channel list automatically
· -u Do not display the successful conversion message

If you pass no options and no file name to iSiloWeb on the command line, iSiloWeb simply starts normally
and if so configured, opens the last opened iSilo channel list. If you pass no options, but do pass the file 
name of an iSilo channel list, iSiloWeb opens the specified file.

To invoke iSiloWeb from the command line and have it automatically convert a specified channel list, 
specify the -c option and provide the file name of the channel list to convert. Use the -u option if you do 
not want iSiloWeb to display the message box stating that conversion was successful. iSiloWeb always 
displays a message box stating that an error occurred if an error occurred during conversion regardless of
whether -u was specified or not.

The following is an example of how to invoke iSiloWeb from the command line and to have it 
automatically convert the specified channel list:

iSiloWeb -c c:\channels\favorite.icl

One use of the iSiloWeb command line is in scheduling automatic conversion of a channel list at specified
times using the Windows task manager. Consult Windows help for more information about how to 
schedule a task.



Channel List Window
The channel list window is the main window of iSiloWeb. It lists the channels of the currently open 
channel list. Each line of the lists shows the most important information about an individual channel. The 
list has five columns of information, each described below.

Channel
This column shows the source location of the channel. It may be an http:// URL or the full path name of a 
file either on the local computer or a computer on the network.

Title
This column shows the title that will be given to the document will hold the channel. If the channel is new 
and has not been converted at least once, this column may be blank. The title of the channel can be 
configured to remain constant or be updated each time the channel is converted.

Destination
This column shows either the name of the user where the channel document will be installed or the path 
of the destination folder for the document.

Comments
This column shows a customizable comment that can be given to each channel. One use of the 
comments is to provide additional information about the content of the channel. Note that the comments 
are not stored in the destination document.

Status
This column shows the status of the last attempted conversion of the channel. If the channel has not yet 
been converted, then the status will be blank.



Channel Properties Dialogs
The Properties dialog allows you to modify the properties for one or more existing channels, while the 
Default Properties dialog allows you to set the default properties for subsequently added channels. 
Configurable properties include channel destinations and HTML conversion options, among others.

Modifying the properties of existing channels
To modify common properties of one or more channels, first select the desired channels. Then invoke the 
Properties dialog in one of the following ways:

· Choose the Properties command from the right-click context menu
· Choose the Properties command from the Channel menu
· Hit Alt+Enter

Setting the default properties for new channels
To set the default properties for subsequently added channels, invoke the Default Properties dialog by 
choosing the Default Properties command from the Channel menu.

Property sheets
The Properties dialog and the Default Properties dialog share the same look, each having five property 
sheets as described in the following sections:

Channel property page
Destination property page
HTML property page
Images property page
Doc/Text property page
Options property page
Comments property page



Channel Property Page
The Channel property page allows you to modify the source and title of a channel and authentication 
information for the channel.

Source
The source edit box allows you to type or modify the URL of a web channel or the path name of a file 
channel. If you want to add a file channel, you can click on the adjacent button labeled with an ellipsis to 
invoke a file dialog to select a specific file. Note that the path name for a file must be the full path name of 
the file.

Title
The title option specifies how to title the channel:

· Specify: Use this option if you want the channel to have a specific title. Enter the desired title into 
the adjacent edit box. 

· Retrieve title automatically during synchronization: Use this option to have iSiloWeb automatically
determine the document’s title. In the case of an HTML document, the title of the channel is taken
from the <title> tag of the document.

· Use the source name for the title: Use this option to have iSiloWeb use the source name to form a
title for the channel. 

User name
The user name for accessing content from the web server of the channel if authentication is required. 
Note that this is not for setting the proxy user name. To set the proxy user name, see Proxy options.

Password
The password for accessing content from the web server of the channel if authentication is required. Note
that this is not for setting the proxy password. To set the proxy password, see Proxy options.



Destination Property Page
The Destination property page allows you to specify where the channel document should be saved.

Automatic installation
Check this option to specify a destination user from the drop-down list of users registered on the local 
computer. When the channel is converted, the channel document will be placed into the user’s install 
directory so that it will be transferred to the user’s device during that users’s next device synchronization.

Save a copy in a specific folder
Check this option to save the channel document to a specific folder under a specifiable file name. If the 
source is a file channel, the destination folder can be the same as the folder of the source by selecting the
Same folder as source option. If you want to specify a destination folder, select the Specify destination 
folder option. Then either enter in a folder name in the edit box right below the option or click the Browse 
button next to the edit box to invoke a folder selection dialog.

You can also have iSiloWeb either automatically generate a filename based on the channel source URL 
or file name or specify a file name yourself. To have iSiloWeb generate one automatically, select the 
Generate automatically based on document option. If you select this option iSiloWeb will generate a file 
name that is unique in the destination folder. To specify a file name, select the Specify option and enter a 
file name in the adjacent edit box. Check the Prompt if file exists during conversion option if you want 
iSiloWeb to ask for confirmation before overwriting the file if it already exists. You can search for a file 
name through a file selection dialog by clicking the Browse button next to the file name edit box.



HTML Property Page
The HTML property page allows you to specify HTML conversion options.

Maximum link depth
The root page is defined to be at a depth of zero. Pages linked to from the root page are defined to be at 
a depth of one. Pages not linked to directly from the root page but linked to from the pages at a depth of 
one are defined to be at a depth of two and so on. The Maximum link depth setting specifies how 
maximum page depth that iSiloWeb will follow.

Follow off-site links
Check the Follow off-site links option if you want iSiloWeb to follow links to pages located at another 
domain. This setting also determines whether images located in other domains are converted if images 
are included as set from the Images property page.



Images Property Page
The Images property page allows you to specify image conversion options.

Include alternative text of images
Most images on HTML pages have text that replaces images when images are not included. Even if 
images are included, having the alternative text displayed may still be useful. Checking this setting 
determines whether the alternative text is included in either case.

Include images
Checking this option includes BMP, GIF, and JPG images in the converted document. Including images 
may increase the size of a document significantly as well as the conversion time. Images are converted to
a monochrome format with optional scaling, contrast improvement, and dithering as specified in the 
options below.

Scale images to a maximum width
If the Include images option is checked, this setting determines whether or not images larger than the 
given maximum width are scaled to that maximum width. Images whose width is no greater than the given
maximum width do not change in size.

Improve contrast
If the Include images option is checked, this setting determines whether or not to improve the contrast on 
images. This setting has no effect on a strictly monochrome image unless it has been scaled.

Dither
If the Include images option is checked, this setting determines whether or not dithering is applied to 
converted images. Since the format of converted images is monochrome, having this setting improves the
look of the resulting images. This setting has no effect on a strictly monochrome image unless it has been
scaled.



Doc/Text Property Page
The Doc/Text property page allows you to specify options when iSiloWeb converts text or Doc documents.
Note that Doc refers to the Aportis Doc document type.



Options Property Page
The Options property page has some miscellaneous options.

Assume that the source file is a plain text file
It is possible at times that iSiloWeb will not recognize a file as a plain text file when in fact the file is a 
plain text file. This will most likely result in a converted document with line breaks removed. To work 
around this, you need to check this option. Checking the option forces iSiloWeb to convert the file as a 
plain text file using the text conversion options.

Page boundaries
Each page of an HTML document results in an individual page in the resulting iSilo document. The page 
boundaries option determines what happens when a document is scrolled or paged at a page boundary.

· Rigid: Neither scrolling nor paging across page boundaries are possible. Note that following a 
hyperlink and other methods of jumping across pages are still possible.

· Hard: This is the default setting. Scrolling across page boundaries is not possible, but paging is.
· Soft: Both scrolling and paging across page boundaries is possible.



Comments Property Page
The Comments property page allows you to enter a comment for the channel. It also shows the status of 
the last conversion and possible details related to the conversion.



Options Dialog
You can use the Options dialog to specify start and exit settings for the channel list, for modifying proxy 
settings, and for setting HTTP options.

Channel list options
Proxy options
HTTP options



Channel List Options
Use the Channel List options page to specify what happens during startup and shutdown of iSiloWeb.

Startup
Check the Open previous channel list on startup option to have iSiloWeb automatically open the last 
channel list opened before you last exited iSiloWeb.

Shutdown
Check the Save channel list on exit to have iSiloWeb save the currently open channel list when exiting 
iSiloWeb. If you check this option, then you can have iSiloWeb either Prompt before saving or 
Automatically save the channel list.



Proxy Options
Use the Proxy options page to specify a proxy server for web requests and if necessary, to specify a user 
name and password for connecting to the proxy server.

Use a proxy server
Check this box if a proxy is required to access the Internet. Enter the address of the proxy server below in
the Address and Port fields. If the proxy server requires authentication, also fill in the User name and 
Password fields.

Address
The proxy server name or IP address.

Port
The proxy server port.

User name
The user name for using the proxy server if authentication is required.

Password
The password for using the proxy server if authentication is required.



HTTP Options
Use the HTTP options page to specify a log file for HTTP connection messages and to set advanced 
HTTP options.



Status Messages
Conversion of a channel may result in one or more errors, in which case iSiloWeb presents you with a 
message box stating that one or more errors occurred during conversion. Possible causes of errors are 
given below based on the message in the status column of the channel.

Error opening source file
iSiloWeb was not able to open the source of the channel. Possible causes include the following:

· If you are converting a web channel, then ensure that you have an active and working Internet 
connection.

· If you are converting a web channel, then ensure that if you require the use of a proxy to access 
the Internet, that the proxy settings are correct. See Proxy options for more information on this.

· If you are converting a file channel, then ensure that the souce file name is correct.

Error opening destination file
iSiloWeb was not able to create the file that will contain the contents of the channel. Possible causes 
include the following:

· A destination for the channel contents was not specified. Either installation to a given user or to a 
given folder must be specified. See Destination property page for information on setting a 
destination for a channel.

· You do not have the authority to create files in the destination location.

Source file is not a supported type
The source document is not one that can be converted to iSilo(TM) format. Currently, only HTML, text, 
and Doc formats are supported by iSiloweb.





Convert dialog box

<< Write a topic here that discusses the Convert dialog box. >>

                                                                      
 




